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1: Canvas Tips and Tricks | Tips and Tricks from CIDI
Text Instructions. Click the Table icon in the toolbar.; Move your cursor over Insert table to open the table creator. Drag
your cursor over the grid and click to specify the dimensions of the table you'd like to add.

Getting Started What is Panopto? Panopto allows for easy recording and sharing of courses, lectures, and
presentations. Panopto is designed to simplify the lecture-capture process. Recordings in Panopto are viewable
on most web browsers and mobile devices. Is there any Panopto training? The workshop schedule can be
found here: Where can I find Panopto? In your Canvas course, select Panopto Recordings from the menu on
the left. You may also access Panopto at uw. Shared NetIDs are not supported by Panopto. The same function
can be done by sharing folders with another NetID. How do I make my Panopto recordings available to people
in my course? Panopto recordings are automatically available to all members of a course via the Panopto
Recordings tab in Canvas. You do not need to have your course content in Canvas to use Panopto. I am
supporting an instructor using Panopto. Can I get administrator or support-level access to Panopto? Panopto
user permissions and course folders are inherited from Canvas. If you need creator-level access to a Panopto
folder, the instructor of the course can add you to Canvas in one of the following roles: See instructions for
sharing. Within your Canvas course, you can embed a recording into a Canvas page this is in addition to the
Canvas navigation menu. Note, however, that if you plan to use course content in future quarters, you must
copy and move Panopto recordings to the new instance of your Canvas course. If the pages are simply copied,
the embedded videos will not be viewable by students in the new Canvas course. Follow these instructions
from Panopto. If a course is jointly listed in the time schedule, how will it appear in Panopto? Panopto folders
are synced up to your Canvas courses. If your course is cross-listed in in the time schedule, you will only see
one Canvas course and one Panopto folder. This course and folder will have the name of the parent course
whichever course comes first alphanumerically. If you intend to manually cross-list your Canvas course,
please email help uw. For more details, see the note for Panopto users on the Canvas Cross-listed courses.
Why is my Canvas course not showing in Panopto? Panopto receives course folder information from UW
Canvas. You will need to publish your Canvas course and click on the Panopto Recordings tab in Canvas to
ensure the connection to Panopto. Publish your Canvas course. If you are not listed as the instructor of record
for a course in the UW Time Schedule, you will not have access to the course. In order to be listed as the
instructor of record you will need to contact your departmental time schedule coordinator. Courses are
automatically provisioned well in advance of the beginning of each quarter. Canvas courses are generally
available as soon as the official Time Schedule for the upcoming quarter is released. See more information
about course availability. Will Panopto show courses I taught in previous quarters? If your course from a
previous quarter is still published in Canvas, the course folder will show in Panopto. Recording Can I upload
an external video file such as a. You may not upload external files to Panopto. If your video library is large,
see http: Is there a place on campus where I can make recordings? Odegaard room was recently remodeled to
allow self-guided, high quality lecture capture recordings. The room is free of charge and is reservable. In
addition, you can schedule recordings in several classrooms. Learn more about scheduled recordings. Can I
create a recording if I am not currently connected to the Internet? Yes, if you have logged in to the Panopto
Recorder while connected to the Internet and not logged out. After your recording is finished and you have
connected to the Internet, click on the recording and selection a destination folder. Click upload to complete
the process. See instructions for recording offline. If you are using the Windows recorder, yes. The Windows
recorder has a background uploading service that will transfer data to the server as long as the recording
computer is on. The Mac recorder does not have this service at this time. Can I schedule a Panopto recording?
If you teach in a classroom that supports the automated Scheduled Lecture Capture the rooms with an
Automated Panopto Recorder in the classroom list , you may use the Recordings Scheduler in Canvas to
schedule some or all of your classes for recording. You can change the schedule at any point during the
quarter as needed for upcoming classes. You may also select to record specific times during your class session,
for example, recording only the first hour of class when you are lecturing. What connector should I use with
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my laptop in a room with automated schedule lecture capture? You will need to connect your laptop to the
classroom VGA input if you want to record your presentation. When a laptop is connected to a classroom
presentation system via one of the ports listed above, the Mac and some Windows laptops output a
copy-protected signal that cannot be recorded. An adapter will allow you to connect your laptop port to the
classroom presentation system via the VGA input cable at the podium. VGA does not pass audio, only the
display. A stereo mini cable at the podium will pass audio when connected to your Mac laptop. Where is the
Panopto remote recording software available? UW-IT does not support remote recording for individual users.
Can I capture my Keynote presentations and what version can I use? Panopto can capture most Keynote
presentation. For more details, see Panopto Keynote Compatibility. Sharing How do I share recordings in
Canvas? UW Panopto is now built into your Canvas course. The course navigation menu in your Canvas
course includes a link called Panopto Recordings. Members of the course can click this link to see recordings
saved to the course. Can I add UW groups to a Panopto recording or folder? Adding UW groups to Panopto
recordings is done using Canvas. Learn how to add people to your Canvas course. How do I share my
recordings? Add additional users to your course What are other sharing options? In new recordings, RSS feeds
and podcasts are disabled by default. To turn them on in Panopto, go to the folder-level settings on the top
right of the page, select Settings, select Settings again, and then check the Enable Podcast Feed checkbox. To
allow downloads, change the drop-down selection from the default of No one to Authenticated users with
access. How do I copy recordings from one academic quarter to another? They do not move with your canvas
course import. You can copy your recordings in a batch and move them. General Questions How do I find out
about changes and new releases to Panopto? To receive email updates, please sign up for our lecture capture
news mailing list. We also post updates on the UW Panopto Updates page , and Panopto publishes release
notes and notifications on the Panopto Forums page. Does UW Panopto offer full Panopto functionality? The
following Panopto features are not offered to UW users:
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2: About Canvas at IU
How do I add an additional email address as a contact method in Canvas as an instructor? How do I view course
content offline as an ePub file as an instructor? How do I change my default email address in my user account as an
instructor?

Add dimension and texture! Login or register to post comments Comments November 1st, at 1: Yes, Opus
prints digital images on canvas. More information about our digital printing service can be found here: A layer
between the print and the clear tar gel is not necessary. Once the print has cured for a minimum of 48 hours,
you can paint directly on the print with acrylic mediums, such as the tar gel, and with acrylic paints, as well.
While a top coat is not essential, it would be beneficial in the long run for giving the print the maximum
protection against UV rays and discolouration. For this, you can use Golden Archival Spray varnish , or
Golden Polymer varnish which is a brush on version. If you intend for the final piece to be stretched, I would
suggest that the stretching is done prior to applying the tar gel or other mediums to get the tightest stretch. I
would also be concerned that the bond between the media and the canvas could be compromised by stretching
afterwards. We are not able to print directly onto boards as our printers are designed for paper and canvas. I
use cradled wood panels but this would work just as well on an art board or any hard surface that does not
warp easily. I mount my own prints this way but with a few modifications. I print my images just a fraction
larger than the surface I intend to mount them on to get a full bleed to the edge once mounted and trimmed.
And then I glue my print to the board and weight it overnight to ensure a good bond. Once all is dry, I trim the
edges and the mounted print is ready to go! Login or register to post comments Pankaj Mehta October 20th, at
I tried Golden Tar Gel on one of my digital canvas I am using a HP Z pigment ink printer, what other golden
product will be safe and give me the similar effect like your video. Here are a few possibilities: It could also
be that the canvas is not accepting the ink as well as it could. If you try letting it dry thoroughly, and the ink
still lifts, you can try spraying on some thinned acrylic medium with a fine mist sprayer, or use a spray varnish
and letting it dry thoroughly before applying the tar gel. It is always a good idea to do some small tests before
applying to full pieces. Golden welcomes product questions and you can contact them directly for further
support with their products: Our Gloss and Satin finished canvases are best for digital prints alone. You will
need to wait at least 24 hours after printing for the ink to fully dry before applying anything to it. It is quite
stable after that. That should be all you need, but for extra security you can also prepare your print by spraying
on thinned acrylic medium or using spray varnish and allowing that to dry thoroughly as well. It is always a
good idea to do some tests on a small print to see if the techniques you want to use will work. After you have
finished your piece you should add a final layer of varnish for protection. We recommend stretching before
you work on the print, however with acrylic paint you may be abe to stretch after as well, but have to be
careful not to damage your work as you do so. For convenience, Opus offers a stretching service when you
order your print. Applying paint will be similar to applying medium as in the video. If you would like to learn
more about acrylic painting, we have some good books check in store for a complete list on the subject,
regular free in-store demos , along with a listing of workshops and classes that happen around BC. You may
be able to do this on your own with the proper camara, tripod, and lighting, or you can find a company in your
area who documents artwork digitally. Once you have a digital file, our pricing and file set up details for our
Fine Art Digital Printing at Opus Page can be found at www. Then apply your gel medium. You can also
apply a coat of diluted acrylic medium before applying your gel medium. It is always a good idea to do some
small tests before working on the full piece. I hope this helps. The printer prints like an ink-jet printer with a
smooth flat finish. Any texture on the prints would be imparted from the choice of surface. For example, if
you print on canvas, there will be a texture from the canvas but not from the ink used to print. I hope that helps
to answer your query. And she dipped her paintbrush into water. Moistening the brush with water prior to
dipping into the gel will slow the drying of the gel on the brush. This is a big help when cleaning your brush
after you have finished painting. I hope that helps. At Opus, we use pigment-based inks that take 24 hours to
fully settle and dry. After that, they are stable to paint on with acrylic paints and mediums, without disturbing
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or altering your print. Applying acrylic paints can help highlight glazes of colour, bring out brush strokes, and
enhance your image. If you want extra security for your original print, you can also prepare your print by
spraying on a thinned acrylic medium, or use spray varnish and allow that to dry thoroughly as well prior to
applying acrylic paints or mediums. It is always a good idea to do some small tests before applying to your
full finished work. I hope this helps! Golden is a great brand and considered by many of our customers to be
the best on the market. They have a wide variety of gel mediums to choose from. Have a look here: The page
also has a video so you can see the different mediums in use. The Stevenson has a little more body than this
one but the next step up, Golden Heavy Body Gel would be quite a bit thicker. The gloss gels do have a lot of
sheen but are also clearer than a matte gel and so would provide more clarity for the your print below. I hope
that helps! All the best to you, Crissy. The Golden Clear Tar Gel has a high gloss finish that dries to be very
shiny, and has a stringy and tar-like consistency, which generates really fine, detailed marble-like lines.
However, it is not designed to be a final finish. For finishing your piece in matte, we have a few
recommendations. In general, it is good to start off with a base layer, known as an isolation coat. The isolation
coat is a permanent, glossy coating that separates your surface from removable varnishes, protecting your
print. This way, if you make a mistake, you can generally remove it without damaging your print. After
applying the isolation coat, you would add several layers of gloss varnish. The reason you would want to first
start off with glossy layers is so that you preserve and bring out the colours of your print. Matte varnish, on the
other hand, dims the colours, and so it requires a minimum of a base layer to prevent a "frosted" appearance.
Applying matte varnish directly onto a print, particularly if you have areas with dark colours, leaves you with
this "frosted" look, as it dries opaque. To achieve a matte finish while preserving the colours, you can use one
of the following methods: Start off with your base layer isolation coat. We recommend using a Golden Soft
Gel Gloss for this: Once the isolation coat is completely dry, you can add several layers of a gloss varnish.
Make sure you dry each layer, and avoid very humid, hot, or cold environments. Adding several layers will
help make your colours pop. Once the top layer has dryed, you can lightly sand the surface, and this will
remove some of the shininess of the finished piece, without damaging either the print or its colours. Top layer
matte varnish: Start off with your base layer very important with this method. Once completely dry, coat your
piece in several layers of gloss varnish, making sure to dry each layer while avoiding very humid, hot or cold
environments. Finally, carefully add a single layer of matte varnish overtop. Additionally, you could mix a
gloss and matte varnish together to create your own recipe for a "satin" varnish. Liquitex and Golden offer
great online resources if you want to see how different finishes dry and affect colours. Please note that it is
always recommended that you experiment prior to varnishing on your finished piece, creating samples on a
surface similar to your finished piece to see which gel and varnish will give you the desired effects for lustre
and transparency, particularly in similar environments - varnishes are highly influenced by temperature and
humidity. You could try asking your local art supply store if they have any opened samples that you could try
in-store prior to purchasing. We have a staff person who has had success painting on digital prints
Hahnemuhle German Etching Paper mounted on a Cradled Panel with oils. She coated the print with several
layers of Golden GAC an acrylic medium that provides a clear barrier between the print and your eventual
application of oil paint , followed by a single layer of clear gesso on top to create a toothier surface on which
to paint, an important step for painting with oils. To complete your painting with a matte finish, you can use a
matte varnish or Cold Wax Medium after applying your Gamvar Pre-Mixed Picture Varnish , which is used to
protect oil paintings. In regards to bleeding, the more acrylic you prime your canvas with, the less dips there
will be in the surface for paint to puddle into. Using a thicker oil paint can also help; the greatest risk you run
for bleeding is if the oil paints are too fluid, or if your acrylic primer is not thick enough. It is important to
note that acrylics are the medium generally recommended when painting on giclee and, as oil painting on
giclee is fairly experimental, the best that we can offer are ideas. It seems that you have already been doing
test prints; as always, we recommend that you test any new techniques prior to applying them onto your
finished piece. Adding the gel texture to a print is not a service that we offer. However, if you are interested in
applying gel texture yourself, you may ask for advice on materials and techniques from Opus staff at any of
our stores or by phone via our Mail Order Department. If you are close to our Opus Langley location, they
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have an upcoming workshop, " Altering Digital Prints to Create a Polished Masterpiece ," that may interest
you if you decide to pursue applying the gel texture yourself. It takes place on Saturday, September 20, , from
I hope this helps, Login or register to post comments
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3: SWOSU Student FAQs for Canvas
In Canvas accounts, admins can allow Open Registration, which allows you to add users to a course even if the users
do not yet have a Canvas account. The user will create an account as part of accepting the course invitation.

In the text field [2], enter the login ID for the user. You can copy and paste multiple login IDs at one time by
placing a comma or line break between login IDs. When searching by login ID, you should use the login ID
format found in the Canvas login page for your institution e. The example format in the login ID field may
differ from the format used in your institution. If you are not sure how to format users for your institution in
the text field, please contact your Canvas admin. Select User Details In the Role drop-down menu [1], assign
the user s a role for the course based on available course roles. In the Section drop-down menu [2], assign the
user s a section in the course. If you want to limit the user s to only interact with other users in their section,
click the Can interact Click the Next button [4]. If you are adding multiple users at the same time, all users
inherit the same role and section. Add Existing Users If Canvas finds an existing user, you can confirm the
user before adding the user to the course [1]. When you are ready, click the Add Users button [2]. If Canvas
did not find your intended user, you can click the Start Over button [3]. View Search Results If Open
Registration is disabled for your institution and Canvas is not able to find a match for the user s , Canvas will
notify you that a match was not found. To try a new search, click the Back button. Add New User If Open
Registration is enabled for your institution and Canvas is not able to find a match for the user s , you can
choose to add the user s to your course. To add all users in the search results, click the Select All checkbox [1].
You can make adjustments to the user name, if necessary. Click the Next button [3]. You are also required to
include an email address for the user [2]. Once you have entered an email address, you can click the Next
button [3]. Add Users Confirm the users you are adding to the course via your selected search method. Click
the Add Users button. Note that observer invitations will only show as pending if the invited observer does not
already have a Canvas account. If you added a user without a Canvas account, the user can create an account
as part of the course invitation process. Once the user has accepted the course invitation, you can interact with
the user in the course. You can also send messages to the user via Conversations. It could take up to 24 hours
for users to receive their invitations. If necessary, you can resend course invitations.
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4: javascript - Creating tables within an HTML5 Canvas - Stack Overflow
I was able to do it like this: First, create the drawing canvas, arrange in front of text, size it, then use Insert > Text Box.
Use the 'Draw Text Box' option. Size the text box, then place your cursor in the upper left of the text box and choose
Insert > Table.

Accessing Canvas What do I need to access Canvas and my classes? Your LMS password will be reset to your
default password, which you can change once you log into Canvas. Please see this tutorial for more details on
how to change your default password to a password of your choice. Here is the list of browsers that will work
with Canvas. Internet Explorer 8 is no longer being actively supported for use with Canvas, so please upgrade
your Internet Explorer browser. Though it will work with Canvas, Internet Explorer is not recommended as a
first choice. Will Canvas work on my mobile device? Canvas functions fully on several smart phones. Others
are functional but these three are currently recommended. Additional mobile applications are planned or are
under development. You can also consult the Canvas Student Guide online here for information about using
mobile apps for Canvas. How do I log into Canvas for the first time â€” what will my username and password
be? The username is not case sensitive but the password is. Instructions for resetting your password will be
emailed to the principal e-mail address in your Canvas account. Please see this tutorial for more details on
how to change your password to a password of your choice. How do I edit my Canvas profile e. Here are the
basic steps: Be sure to save any changes you make. How can I add or change a profile picture? Please click
here for a tutorial on adding or changing your profile picture in Canvas. Where does this profile picture
display? Next to your discussion posts and in course rosters, for example. Which time zone does Canvas
operate in? You can set your personal profile to reflect the time zone you are in if it differs from Mountain
Time. Please check with your instructor regarding deadlines if your time zone is significantly ahead or behind
Mountain Time. Students can click on the Help link at the top right corner of the screen while logged into
Canvas to request help. The Canvas student manual is posted online in the Canvas Guides. Is a student
orientation for Canvas available? Yes, we have an Explore Canvas for Students module available that teachers
can copy into their Canvas courses. How do I customize the Notifications I receive from Canvas? By clicking
on the Settings link in the upper-right corner of the Canvas screen after logging in, users can: Will my teacher
e-mail me from Canvas? Instead, Canvas assumes that with the ability to set up custom Notifications, students
are getting the message in the channels they prefer, but that important conversations should be in one central
location: Instead of e-mailing out to users, Canvas uses its Conversations tool, an internal messaging system
entirely based within Canvas. Click here for a tutorial on Conversations. When can I access my courses? You
typically will not have access to your courses in Canvas until the first day of class. You do not need to request
access as you are automatically enrolled after registration in your Canvas course s. If you register on the first
day of class or after that date, it may take one business day before access is available as we update the
information periodically, not instantaneously. In order to view your course in Canvas, two things must happen:
You must be officially enrolled in the course; and your instructor must have "published" the course to make it
available to students. If an instructor asks you to access a Canvas course but it is not listed in your My Courses
list, ask your instructor if the course has been published yet. If the instructor has published the course, ask
your instructor to check if you are on the roster. If you have recently registered for the course, please allow
one day for your enrollment to be added to Canvas. What happens in Canvas when I drop a course? If you
drop a course, then that course is deleted from your course list. You can no longer access that course once the
system has had time to process your change in registration typically this takes one day. How do I access them?
Canvas displays up to 12 courses in the Courses drop-down menu. Once users have more than 12 courses, they
may customize the drop-down menu to choose which courses will display. Click here for a tutorial on how to
do so. After a semester ends, your courses from that semester will be retired from your course list. In any case,
you can always access all of your courses, past and present. How can I customize my course list? You can
customize the list of courses you see from the dropdown menu of Courses. Please click here for a tutorial on
customizing that course list. How do I upload files for my Assignments? Can I cancel a submission for an
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Assignment? No, it is not possible to cancel your submission to an Assignment in your Canvas course. You
can however return to that Assignment and re-submit your work, as long as the Assignment is still open for
submissions. You can also write a comment as you submit work to explain the situation to your instructor.
Canvas will keep track of the time and date each file is submitted for your instructor. However, be aware that
you will only see your most recent submission for an assignment if you return to the page where you
submitted or check the Grades section. Can I submit files multiple times for an assignment? Yes, you can
return to an assignment and submit your work again, as long as the instructor has not restricted the assignment.
You can also write a comment as you submit work. How do I know if I can retake a quiz? Return to the quiz.
If you see the button marked "Take the Quiz Again," then you are allowed to take the quiz again. If you are
having an issue with a quiz, please contact your instructor for help. Can the instructor give me extra time on a
quiz or extra quiz attempts? While this is technically possible for Canvas, you will need to check with your
instructor to determine if he or she will give you extra time or extra attempts on a quiz. If you return to a quiz
and see a button marked "Take the Quiz Again," then that quiz is set up to permit to you to take the quiz again.
How does the Turnitin anti-plagiarism tool work? Turnitin is integrated into Canvas. Turnitin often adds new
content to keep its service up-to-date. What about the Turnitin anti-plagiarism tool and my assignments? Your
instructor has the option of enabling the Turnitin anti-plagiarism tool to check assignments that are submitted
online in your Canvas course. The Turnitin student manual can be found online here. Student tutorials and
FAQ about Turnitin can be found online here. The instructors decide whether to share the matching paper
depending on the circumstances. Turnitin agrees that students should own the copyright to their original work.
A common misconception is that students relinquish their ownership rights when they submit papers to
Turnitin. Students who submit papers to Turnitin retain the copyright to the work they created. For more
information on privacy and Turnitin, please click here. I need tech support for Turnitin, the anti-plagiarism
tool. SWOSU students and instructors can submit a ticket by visiting turnitin. Please see this tutorial on how to
reply to a Discussion post. Look for the word "Reply" and the arrow at lower left, below the post you wish to
respond to. Click there to create a new post. What does subscribing to a discussion mean? You can "subscribe"
to discussion threads within your courses and be notified when there are new comments. This means that
Canvas will notify you when new comments are posted to the Discussions in your courses. Please note that
users cannot subscribe to individual threads within a threaded discussion. If you create a Discussion yourself,
you will automatically be subscribed to that Discussion. You will also automatically be subscribed to any
thread you respond to, but you can manually unsubscribe at any time. For a tutorial on subscribing and
unsubscribing to Discussions, please click here. How do I attach files to my discussion posts? Your teacher
must turn on a particular course setting to enable you to attach files to your posts in discussions.
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5: How to Print on Canvas: 10 Steps (with Pictures) - wikiHow
It would appear that the best way to do this is to convert the data from the table into a canvas and then call toDataURL
to get an image. After searching through a lot of the tables mentioned here it looks like all of them just put a wrapper
around a regular html table to make it look fancier.

If your project is already finished, you can still add margins to it by manipulating the canvas and image size
options available in Photoshop CC Adjust the canvas size, then the image size to add Photoshop margins.
Image courtesy of Adobe. Launch Photoshop and press "Ctrl-N" to create a new file. Specify the width and
height for your finished project, including margins. For example, if you want a pixel margin around a
pixel-square image, make the height and width "" pixels each. If you are printing the project on standard
paper, click the "Preset" menu and select "U. Press "Ctrl-R," or click the "View" menu and select "Rulers. The
ruler is already aligned to the upper-left corner of the canvas. A text box positioned to the rulers. Insert any
objects such as images, shapes or text boxes into the document. If any objects in the canvas overlap the edges
of the current canvas, select "Merge Visible" from the Layer menu. Margins added using the Canvas Size
window. Select "Canvas Size" from the Image menu. Put a check mark in the "Relative" check box. Select
whatever margin you want to add to the document, such as ". Click "OK" and the additional space you
specified is added to the image as empty margins. The Image Size window with a locked aspect ratio. Resize
the image size back to its former dimensions if needed by clicking the "Image" menu and selecting "Image
Size. Change the "Width" to what it was originally. The height is automatically changed in proportion to the
reduced width.
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6: Canvas Instructor Guide - Table of Contents | Canvas LMS Community
What are Assignments? Canvas considers any graded item as an assignment. Instructors can also set up non-graded
assignments. These include: Assignments: An Assignment is a Canvas assignment that can be submitted online
through text entry, file uploads, media recordings, Google Docs, URLs, or Canvas pages.

The tool that allows you to access Wimba live classrooms is the Conferences tool. This post will give an
overview of how to create and manage your online classroom Conference. We will also discuss some common
issues that you may encounter and how to avoid them. Click the Make a New Conference button on the
upper-right-hand side of the window. The Start a new Conference settings will appear and you can make
changes to the following options. Allows you to give your conference a unique name. We suggest changing
this to something other than the default Course Conference so it can be easier to find for administrative
purposes. The long-running conference prevents the conference from closing after the duration of the
conference has ended. Once a conference has ended it is preserved in the state that it was at the time it was
ended. This means that any new course members will be unable to view the archives and you will no longer be
able to use the conference for any new sessions. It is best to enable this for frequently used conferences, such
as weekly lecture conferences, as the conference will not automatically close and become unusable and the
archives will be available to all course members. If the conference is only going to be used once and you know
the approximate time limit you can specify it in the minutes textbox. Let participants know what the
conference is used for. You can include information such as the phone number and classroom PIN number
they can call if they are having audio difficulties. By default Invite all Course Members is enabled. If you wish
to do a special conference with only certain students, uncheck this option and you will be able to select
individual students. When you have finished changing the settings for your conference click the Create
Conference button to finish. When you click the Start it now button an invitation will be sent to selected
course members with a link to the conference. After clicking the Start it now button your conference will start
and you will be taken to your conference. The next time you view the conferences page you will see two new
buttons, Join it now and End it now where the Start it now button used to be. It is preserved in its current state,
new or uninvited course members will be unable to view the archives if any exist. Once you end a conference
it cannot be re-enabled. Editing a Conference From the Conferences tool click on the title of the conference
you would like to make changes to. The Conference Details will be displayed. The conference details page
contains information about the conference, links to archives, and the currently invited course members. To edit
the conference click the Edit Conference Button on the right-hand side. Here you can change the settings of
your conference. If you would like to change advanced settings pertaining to the Wimba live-classroom click
on the Manage Advanced Settingsâ€¦ link. Once you have made any modifications click the Update
Conference button to save your changes. Viewing Archives From the Conferences page click on the
conference you would like to view archives for. In the External Links section, click the View archives s link.
A window will appear listing the available archives. Best Practices If you are going to host frequent
conferences such as weekly lectures and hold office hours, you can create just one conference and use the
conference description to let students know the times of each. Make sure that the long-running conference
option is checked, and do not end it when you are finished with your session. This will ensure that students are
not confused as to which conference room to go to. This can cause problems in the future if new students
enroll in your class and need access to archives. If you would like to repurpose an existing conference you can
use the announcement tool to inform students of the change and re-post the link to that conference. If students
are having difficulty entering the conference from links sent through notifications to their email, have them
enter from the link in the conferences tool. If you have given a conference a time duration you may want to
add minutes and start early so you and your students can deal with technical issues that may arise.

Page 10

HOW DO I ADD A ABLE TO CANVAS pdf
7: SWOSU Grading and Testing FAQs
You have to add your canvas element to the DOM by using a function like appendChild(). For instance, to add it in a
div#myDiv, you can do write the following code: www.enganchecubano.commentById('myDiv').appendChild(canv).

Add a drawing to a document Click in your document where you want to create the drawing. On the Insert tab,
in the Illustrations group, click Shapes. When you find the shape you want to insert, double-click to insert it
automatically, or click and drag to draw it in your document. You can do any of the following on the Format
tab, which appears after you insert a drawing shape: On the Format tab, in the Insert Shapes group, click a
shape, and then click somewhere in the document. Click the shape you want to change. Add text to a shape.
Right-click the shape, click Add Text, and then type. Select several shapes at a time by pressing CTRL on
your keyboard and clicking each shape you want to include in the group. On the Format tab in the Arrange
group, click Group so that all of the shapes will be treated like a single object. Draw in the document. On the
Format tab, in the Insert Shapes group, expand the shapes options by clicking the arrow. Under Lines click
Freeform or Scribble. Adjust the size of the shapes. Select the shape or shapes you want to resize. On the
Format tab, in the Size group, click the arrows or type new dimensions in the Shape Height and Shape Width
boxes. Apply a style to a shape. In the Shape Styles group, rest your pointer over a style to see what your
shape will look like when you apply that style. Click the style to apply it. Or, click Shape Fill or Shape Outline
and select the options that you want. Add flow charts with connectors. Before you create a flow chart, add a
drawing canvas by clicking the Insert tab, clicking Shapes in the Illustrations group, and then clicking New
Drawing Canvas. On the Format tab, in the Insert Shapes group, click a Flow chart shape. Under Lines, choose
a connector line such as the Curved Arrow Connector. Use shadow and three-dimensional 3-D effects to add
interest to the shapes in your drawing. Align the objects on the canvas. To align the objects, press and hold
CTRL while you select the objects that you want to align. On the Format tab, in the Arrange group, click
Align to choose from an assortment of alignment commands. Delete all or part of a drawing Select the
drawing object that you want to delete.
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8: Add a drawing to a document - Word
Adding a half-inch margin to a letter-sized document, for example, results in an image that's inches wide and inches
high. If you don't mind your canvas being stretched that extra inch, you can unlock the aspect ratio when changing the
width and height.

Canvas Gradebook How does the Canvas Gradebook work? The Gradebook provides the instructor a means of
easily inputting and distributing grades for students as the semester progresses The Canvas Gradebook can
serve as a communication tool between students and instructors and allows the instructor to monitor the
activity of high-risk students. The Gradebook can calculate weighted grades, and assignments can be
organized into groups for weighting as well. In Canvas, any graded task or item is considered an "assignment"
so you may see that term used pretty widely! The Canvas gradebook is a fully featured management tool that
allows instructors to: Be notified when assignments submitted. Notify students when an assignment has been
graded. View Grade history and revert updated assignment scores to previous scores. Download or upload
grades from the Gradebook as a CSV file. Utilize offline grading capability by downloading assignment
submissions into a zip file and upload when connectivity is available. Elect not to let students view their
grades until they are published. Create custom weighting and grade ranges. Report of all historical grade
changes is available to the instructor. Message students whom have not submitted yet, or scored more than X
or less than Y on an assignment. What are Assignment Groups? As you create Assignments, Quizzes, graded
Discussions and so on, you can organize them using Assignment Groups. You will name your Assignment
Groups as you create them. Assignment Groups can contain various kinds such as graded Discussions,
Quizzes, and Assignments. Besides organizing items, Assignment Groups are a must if you intend to use a
weighted total to calculate final class grades as explained in our Canvas Grading and Testing FAQ. Plus, with
Assignment Groups, you can set up grading rules that will govern how grades for items in that Assignment
Group are handled by Canvas. For example, in an Assignment Group, you can drop the lowest grade or drop
the highest grade out of that group. You can also specify which Assignments should never be dropped from
the Assignment Group calculation, and more. By default, all Canvas courses start off with one Assignment
Group named Assignments. You can find it listed in the Assignments section of your course. View a tutorial
on creating Assignment Groups. When do students find out that I have entered or changed a grade? By default,
as soon as an instructor posts a grade students who visit the Canvas course will be able to see it, unless the
instructor "mutes" the assignment see question on muting on this page. Students will need to set their
notification preferences to be sure to receive prompt notifications about grades. Please see the page on
Notifications. How can I add columns to the Gradebook? In Canvas, you can only generate more columns in
the Gradebook by creating new graded items, such as tests, assignments, and graded discussions. You can
however create assignments that are set to not require any submission by students and manually input grades
into the column that is generated. How do I sort my Gradebook? Click on the Grades link to open the
Gradebook. Click on the drop down menu next to the Gear icon to access the Gradebook sorting options. See
the complete, illustrated instructions for Gradebook sorting options. How do I enter and edit scores in the
Gradebook? You can still overwrite these scores and adjust them in your Gradebook. View a tutorial on
inputting and editing scores in columns in the Gradebook. How do I enter letter grades into the Gradebook? In
Canvas, you do not actually type letters into your Gradebook or the SpeedGrader. Instead, you must use a
grading scheme. The grading scheme will correlate percentage ranges or scores to specific letter grades. You
can enable the default grading Canvas scheme or create your own grading scheme in your Canvas course, then
enable your custom grading scheme. Does the Gradebook count ungraded items as zeroes? Click on the gear
wheel icon at the far left end of your Gradebook, above the list of students. View a tutorial on how to leave a
comment providing feedback for students via the Gradebook. You can also provide students with comments
when using SpeedGrader. Your comments to individual students are private. How do I send a message to my
students from the Gradebook? View a tutorial on how to message certain categories of students from within
the Canvas Gradebook. How do I curve grades in the Gradebook? How do I drop the lowest score? In order to
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drop the lowest score from a selection of assignments, you must set up Assignment Groups. View a tutorial on
creating new Assignment Groups. View a tutorial on how to drop the lowest score within a group of
assignments, please click here. How do I weight grades in the Gradebook? By default, when you create graded
items like assignments, tests, and discussions, Canvas categorizes them as belonging to its default Assignment
Group named "Assignments. For a tutorial on weighting the final grade based on Assignment Groups. How
can students view what the average class grade is for a particular graded item in their course? To see what the
average class score is for a particular graded item, students must click on the Grades button in the left
navigation panel of their Canvas course, and then once they arrive at the Grades screen, they must click on the
"Show All Details" button at the right. This will reveal a graphic underneath each assignment title. How do I
grade attendance, participation, etc. In general, you will need to create an Assignment that is set to not require
any submission. In the options for submission, choose "No Submission. Students would not have a "submit"
button so they would not be confused by the presence of this Assignment. Additionally, if you need a
weighted total for a final class grade which involves something like attendance, you could create an
Assignment Group for that category. You would then be able to calculate the Attendance Assignment Group
as a designated percentage of the final grade. View a tutorial on Assignment Groups. How do I bulk download
and upload submitted assignments in Canvas? From the Canvas Gradebook, you can download all the
submitted work for an assignment at once; make comments on those submissions, then bulk upload them for
students to view. Students will see the uploaded files in the comments section for their submission. See
instructions on how to bulk download and upload submissions. How can I view the Gradebook as a student?
Canvas has a "student view" feature that you can use to view your course in general as a student would,
including even taking tests! View a tutorial on how to launch the student view. Launching the student view
feature adds a dummy "test student" to your Gradebook. By default, Canvas allows students to see grades as
soon as the instructor has graded the assignment, discussion, etc. In some cases, instructors may wish to
prevent students from viewing their grades in order to release grades to all students at the same time. To hide
student grades temporarily, an instructor can choose to mark an assignment as "muted. View a tutorial on
muting an assignment. Canvas Assignments permit students to upload multiple times for the same
Assignment, which enables them to turn various drafts of their work. Each submission is marked with the date
and time it was submitted so you can easily distinguish among them. Canvas will also mark if a submission
was turned in past the deadline. How can I issue the same grade for all students for one assignment? Issuing
the same grade for all students for one assignment or other graded item is called issuing a "default grade" in
Canvas. You can also override any grades than have been issued and set the grade, this way the entire column
can be populated with the same grade. There is no way to populate the entire gradebook with default grades.
You cannot go through an put zeroes in for missing grades. Only individual assignments can be issued a
default grade How can I see the total points earned by a student not the percentage? The Total column is at the
far right end of the Gradebook and is generated automatically. This feature offers grading flexibility for
instructors depending on their preferred grading styles and can be accessed by hovering over the Total column
and selecting the grading view of choice. Students will receive this viewing functionality in an upcoming
upgrade to Canvas; and students can still see cumulative points by hovering over their totals. Please note that
this feature is only available in the Gradebook for courses that did not set up a weighted total using
Assignment Groups. How can I set up a grading scheme so that I can use letter grades in my course? A
grading scheme correlates percentage ranges or scores to specific letter grades. For a tutorial on how to create
a grading scheme. How can I set up extra credit in my Gradebook? How does the Canvas SpeedGrader work?
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9: How do I add users to my course? | Instructor Guides | Canvas @ Yale
Add your own syllabus to Canvas. Canvas generates a syllabus for you when you add assignments and due dates to
your course. But if you prefer to use your own syllabus, it's easy to copy and paste your syllabus or upload
www.enganchecubano.com,.docx, www.enganchecubano.com file.

Please view the video below regarding how to add people to your course: Open People In the course
navigation, click the People link. Add People Click the Add People button. Select User Search Type In the
pop-up window, select how you want to add people. You can add them by their email address [1] or by their
NetID [2]. If you need to use the Yale Directory to look up an individual, you can do so by clicking "Yale
Directory" [3]. You can add multiple users at one time by putting a comma between each user. Remember, do
not use the protected roles. Roles that you can use include: Click the Next button [4]. Add Users Canvas will
verify that the account is valid [1]. If you are not ready to add the user, click the Start Over button [2].
Otherwise click the Add Users button [3]. Canvas will automatically send the user an invitation to participate
in the course. Once the user has accepted the course invitation, you can interact with the user in the course.
You can also send messages to the user via Conversations Inbox. Just click the gear icon [1] to the right of the
user you need to update and then click the "Edit Role" button. Select new role Select the new role remember
not to select a protected role from the Role drop-down menu [1] and the click the Update button [2]. If the user
is being enrolled into the course by registrar data, you will not be able to remove them. Remove User From the
People Tool, click the three dots associated with the user you would like to remove [1] and click Remove from
Course [2]. Form more information about how to add users:
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